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How to Run a Lender Search Report - Lenders

1. Access the Lenders Reporting System (LaRS) by clicking on the following ur!
link:

http://www.fp.ed.gov/fms.html
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What is FMS? . TOP
RIS GAFR--Form 2000

4 F'\Inanclal FSA's Financial Management System (FMS) is a centralized system for all
éfsntza??em FSAfinancial transactions. It allows FP users to: collect, process, maintain,
- transmit, and report data about financial events ON-LINE. It also provides B
Financial Partners functionality to support financial planning and budgeting activities, Click here to access
Data Mart "
accumulate and report cost information, and the preparation of financial
NSLDS statements.. LaRS (formerly ED
FSA Links Form 799)
# The following FP applications can be accessed by clicking on the
Other FSA Sites 'GAFR’,"LaR3’, 'LEAP/SLEAP", or LAP icons on the right. <
G & AllFMS users are required to submit updated FSAFNS Securify
P ammatic Links e
i " Forms annually with the U.S. Department of Education
Supportive Links

Click here to access
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Interest Rates LEAP/SLEAP

Guaranty agenices use the Guaranty Agency Financial Report to request
payment from and make payments to the Department of Education (ED)
under the Federal Family Education Loan (FFEL) Pragram. Priar to
entering GAFR data electronically users are required to

Click here to access
Submitthe required FSAF

ecurity
rt (GA

ms.
R) Instruction Guide (PDE

* Financial Management System Guaranty Agency User Guide
(PDF - 52 pag

ency Financial Report (GAFR-Form 2000

Lender Reporting System (LaRS) . TOP

Lender Reporting System (L aRS)

Lenders are required to submit quarterly student loan portfolio data to
receive payments and to report origination/lender fees due to the
Department of Education (ED). These payments are based on the
transmission of valid financial data via the Lender Reporting System
(LARS). The LARS integrates access to lender data through one system
and creates ad hoc query analysis functionality. Prior to entering LaRS data

€ Local intranet | Protected Mode: Off #100% -

Lender Search Re|

2. Click on the 'LaRS (formerly ED Form 799)' link on the right-hand side of
the web page to access the LaRS application.


http://www.fp.ed.gov/fms.html
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An OFFIGE of the US, DEPARTMENT of EDUCATION

+Terms of Use This is a Government system, to be used by authorized personnel only. If you use this

computer system, you should understand that all activities may be monitored and recorded
by automated processes and/or by Government personnel. Anyone using this system
expressly consents to such monitoring. Warning: If such monitoring reveals possible
evidence of criminal activity, monitoring records may be provided to law enforcement
officials. This system contains personal information protected by the Privacy Act of 1974
(as amended). If you use this computer system, you are explicitly consenting to be bound
by the Acts requirements and acknowledge the possible criminal and civil penalties for
violation of the Act.

| -
L 1 Agree I Disagree

Copyright 2005. Federal Student Aid - Financial Management System.

Privacy Statement

3. After clicking on the LaRs link the following message regarding the
Terms of Use appear. Please read and click on the 'T Agree’ button.
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| Federal Stodent Aid

You are accessing a U.S. government information system, which includes this computer session, this computer network, all computers
connected to this network session. This information system is provided for U.5. government-authorized use only. Unauthorized or
improper use of this system may result in disciplinary action, as well as civil and criminal penalties. Personnel using remote access shall
not download or store government information on private equlpment optical or digital media. By using this information system, you
understand and consent to the following: You have no reasonable expectation of privacy regarding any communications or data
transiting this information system. At any time, the government may monitor, intercept, search and seize any communication or data
transiting this information system. Any communications or data transiting this information system may be disclosed or used for any
purpose.

By logging on, I agree and consent to these terms and conditions.

Login
Username

Password
Token

| Login
Register Token

LostForgot Token

Copyright (c) 2006, Oracle. All rights reserved.

Privacy Statement _

4. Affer clicking 'T Agree’, the login screen will appear.
a. Enter the username assigned to you by FSA FMS Operations in the
User Name field.
b. Enter your password in the Password field.
c. Enter the number generated by your Token.
d. Click on the Login button.
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a Oracle Applications Home Page - Microsoft Internet Explorer _ ;lglzl

File Edit Wiew Favorites Tools Help ﬁ

GiBack + =+ (D at | Qhsearch [GelFavorites EFMedia &4 | BN S =

Address @ htkps:} fr5470-12.ed.gov: S008/OA_HTMLIOA, jsprOAFunc=C0AHOMEPAGE j @Go | Links **
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ORACLE E-Business Suite

Home Logout Preferences Help

Logged In As LARS LENDER

| Cracle Discoverer )

Navigator
[ FSA LARS Lender/Servicer Flease select & responsibility. |
Worklist

| Full List )

From Subject Sent
There are no notifications in this view.

@ TIP Yacation Rules - Redirect or auto-respond to notifications.
@ TIP Worklist Access - Specify which users can view and act upon your notifications.

Home | Logout | Preferences | Help

Copyright 2000-2005 Oracle Corporation. Al rights reserved. Privacy Staternent
E
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5. Once your login has been verified, double-click on 'FSA LARS Lender/Servicer’
to select a responsibility.
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73 Oracle Applications Home Page - Microsoft Internet Explorer

[0l x|
File Edit ‘iew Favorites Tools Help i

FBack + = - @ at | @Search [Fe] Favorites @Media @ | %v =M=

Address IE https:,f,fr5470-12.ed.gov:SDDS,I’OA_HTML,I’OA.jsp?OAFunc=OAHOMEPAGE&akRegionApplicati0n1d=D&navRespId=50294&navRespAppId=20039&navSecGrij @Go | Links **

ORACLE E-Business Suite

-

Home Logout Preferences Help

Logged In As LARS LENDER

| Cracle Discoverer )
Navigator

| Edit Mavigator |

[WJFSA LARS Lender/Service FSA LARS Lender/Servicer

FSA LaRS Form
FSA LaRS Profile

Others

Prafile

Concurrent

Change Organization

Others : Requests

Run <
Set
Worklist
| FulrList )
From Subject Sent

There are no notifications in this view.
@ TIP Yacation Rules - Redirect or auto-respond to notifications.
@ TIP Worklist Access - Specify which users can view and act upon your notifications.

Home | Logout | Preferences | Help

Copyright 2000-2005 Oracle Corporation. &1 rights reserved. Privacy Staternent LI
] [ [ 18 [ mtemet Z

6. Under the heading Others: Requests, double-click on ‘Run’.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05 = |EI|5|
File Edit “iew Folder Tools Window Help
(HAYO & 2VSP R DBHAL LEDHE 2 )
Func Documents
FSA LaRS Form
LaRS Form for Lenders & Servicers
FSA LaRS Form Top Ten List
FSA LaRS Profile
# + Others
-
#Sl
#.# What type of request do you want to run?
=
-
This allows you to submit an individual request
 Request Set
This allows you to submit a pre-defined set of
requests.
( oK [ cancer |
Recard: 101 | | =05C= J

7. After double-clicking on 'Run’ the Submit a New Reguest window will

appear. Click on the "OK' button.
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— Run this Request... -
( Copy...
MNarne Click on List
| Q of Walues
Parameters | (L% Button
Language |
( Language Settings. .. I Debug Options
— At these limes...
Fun the Job |As Soon as Possible ( Schedule. .
— Upon Completion...
v Save all Output Files
Layout
Notify Options. ..
Print to |
Help (C} ( Submit | [ Cancel )

8. Affer clicking on OK, the Submit Reguest window will appear. Place your
cursor in the name field and click on the list of values button.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05 = IEllil
File Edit “iew Folder Tools Window Help
CEEIE )

4% O Bubmit Request

B8P I ADDEH LD ?

~ Run this Req

Mame

Language
¢~ At these Times... —
Run the Job

~ Upon Completion...

Layout
Motify
Print ta

Help (C)

Chuoices in list: 2
Record; 1/1 |

Copy

Find|Lender Search Reportfar %

Mame Application
Lender Search Repaort for Lenders SA LARS
Lender Search Report for Servicers FSALARS
‘l ))))))))))))))))))))))))))))))))) | »

.. | Ustofvalu... | | =05C=

9. After clicking on the list of values button, the Reportswindow will appear
with the name 'Lender Search Report for Lenders’highlighted. Click ‘OK'.

FederalStudent PROUD SPONSOR o

Aw DFFICE of the UWE. DEPARTMEMNT of EDUCATION




Running a Lender Search Report - Lender

& Oracle Applications - Copy of Production to UPGRDS 10-19-05 = IEllil
File Edit “iew Folder Tools Window Help
CEEN I YYD I T I I Y] Ik J

4» O Submit Request

~ Run this Req

Mame
Parameters
Language American English

Language Settings...

Copy

Debuy Options

Run t

Lender ID [877411 877411
~ Upon Compl Report Year 2005
Report Guarter |2

A e e e T i,

lQanceI)I (ClearJI (Help JI

L3

]

Help (C) Submit

Cancel

Record; 1/1 | .. | Ustofvalu... | | =05C=

9.

Next the Parameters window will appear.

A. In the Lender ID field, enter your lender id humber.

B. In the Report Year, enter the year of the reported 799 that you

want to view.

C. Inthe Report Quarter, enter the quarter (1,2,3 or 4) of the
reported 799 you want to view. Or you can leave this field blank and

all the quarters for the Report Year will display on the report.

D. Click the OK button.
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g.?g Oracle Applications - Copy of Production to UPGRDS 10-19-05

File Edit “iew Folder Tools Window Help

=lolx|

(B2 &8 P AN Ex L2808 D

~ Run this R

Copy...

Mame |Lender Search Report for Lenders
Parameters [877411:2005:2

Language |Amerit:an English

( Language Settings.. Debug Options

¢~ At these Times...

Run the Job |As Soon as Possible Schedule

~ Upon Completi
W Save all Output Files

Layout |

lotity | Optigns...

Pririt to |“°I"i“t

Help (C) ( Submit | | Cancsl )

Record; 1/1 | | =05C=

11. Click on the 'Submit' button to run the report.
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& Oracle Applications - Copy of Production to UPGRDS 10-19-05 ;|g|5|
File Edit “iew Folder Tools Window Help
EETrNIIY YR ITIIrriFl-I Yl ik J
( Refresh Data | [ Find Reguests J ( Submit a Mew Heguest... J
Request ID Parent
_ Mame Phase Status Paramsters
JIBEEE  |Lender Search Reportfo| [Peniing " [Narmal W 877411, 2005, 2 -
[1510864  |Lender Search Report fo | [Completed  [Normal 877411, 2005,
l | | | | \
| | | | | \
I | | | | \
l | | | | \
| | | | | \
I | | | | \
| | | | | \
| | | | | \ -
( Hold Request | [ Yiew Details. .. ) ( “iew Cutput
( Cancel Request | [ Diagnostics )I ( Wiew Log...
FRM-40400: Transaction complete: 1 records applied and saved | |

il start HDesktop »|J 80 H a |J & loracle .Qp...l &oracle Ap..‘l ®Windows...| @LenderSa.‘.l @LanderSa..“@Dracle A, |<ﬂ$®o%3a% 12154 PM

12. The Reguest window will appear. Click on the Refresh Data button until the
Phase column for this report indicates Completed and the Status column
indicates Normal. (Note: this report should take approximately one minute
to run).
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g.?.‘} Oracle Applications - Copy of Production to UPGRDS 10-19-05 = Ellﬂ
File Edit View Folder Tools Window Help
(R0 &HVBEP ADDERLBOD %I ? )

O Requests [+

(

Refrash Data

Find Reguests J (

Submit a New Request...

Request ID

Mame

Parent

Phase Status

Pararneters

.||M_|Lender Search Report fo ‘

‘Completed |Norma|

877411, 2005, 2

[1510854

|Lender Search Report fo ‘

‘Completed |Norma|

877411, 2005,

[»

1]

( Hold Reguest Yiew Details... J ( Yiew Output |,
l
( Cancel Reguest Diagnostics J ( Wiew Log... )I
Record: 1/2 | | =05C=

13. Click 'View Output’ to view the report.
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NDWRR.exe?temp_id=1048355993 - Microsoft Internet Explore: =1Ol=l
File Edit ‘Wiew Favorites Tools  Help ﬁ
g=Eack - = - &) fat | @ search  [GelFavorites GMedia o4 | B S =
Address [ @] http:/r5470-11.ed qoviB005/0A_CGLIFMDWRR, exe?temp_id—1048355993 | e |Links »

=
RUN DATE: 10/06/05 Il
U.S. DEPARTMENT OF EDUCATICN
FEDERAL FAMILY EDUCATION LOAN PROGRAMN
INTEREST PAYMENTS SUBSTSTEMN

LEMDER SEARCH REFORT

LENDER: 877411 DUMMY LID FOR ED ACCTG FFELP ADMIN USE ONLY WASHINGTON | |
SUMMARY FOR: z / zoOos SERVICEER ID: STATUS: Aocepted PROCESSING DATE: 10/
GROSS3-TINTEREST: 3642.30
GROSS SIPECIAL ALLOWANCE: 35258.58
LE23 ORIGINATION FEES: §1,050.00
LEZ3 LENDER FEE3: §250.00
TOTLL DOCUMENT AMOUNT: -§1z29.1z2
F/B INT LN ENDING LVERAGE
QTR/YEAR CODE FEE RATE TT SAC BALALNCE BALANCE ADJUSTHENT
PART I
0z/ zoOo0s FI .03 EVAER 3F $10,000.00 j0.00 $0.0
0z/ zoOo0s LI .A05 EVAER 3F $10,000.00
0z/ zoOo0s FI .03 EVAER =31 $20,000.00
0z/ zoOo0s LI .A05 EVAER =31 $20,000.00 _J:J
| »

|
&] Done l_ l_ l_ |4 nternet v

14. The report will be open in the web browser.

FederalStudent PROUD SPONSOR o

& GFFICE of fhe ULS. DEPARTMEMT of EDUCATION



Running a Lender Search Report - Lender

r5470-11.ed.gov:8008,/0A_CGI/FNDWRR.exe?temp_id=1904719367 - Microsoft Internet Explorer _|EI|1|
File Edit Wiew Favorites Tools  Help ﬁ
Hew 4 mSearch [GlFavorites  GMedia 4 | By S =
Open... Chrl+0 s
Edit 1800804 _CGIL/FNDWRR exettemp_id=1904713367 j @GD |L|nks
3 a Al
U.5. DEPARTHMENT ©OF EDUCATICH
Page Setup... FEDERAL FAMILY EDUCATICN LOALN PROGRALM
Print... Ctrl+P INTEREST PALYMENTS SUBSYITEM
Prink Preview. .. LENDEE 3EARCH REFPORT
Send 3
LEHE e B o r LID FOR ED ACCTG FFELP ADMIN USE CNLY VASHINGTON DC 20202
Properties
wark OFfline aons SERVICER ID: STATUS : Aecepted PROCESIING DATE: 10/06/2005 b
Close
GROS3-INTEREST: $642.30
GROS3 SPECIAL ALLOWANCE: $528.58
LEZS ORIGINATICN FEES: $1,080.00
LESS3 LENDER FEE3: $250.00
TOTAL DOCUMENT AMOUNT: -3129.1z2
F/E INT LM ENDING AVERLGE AT
QTR/ YEAR CCODE FEE RATE TY SAC BALLNCE BALANCE ADJTITHENTS Cl
PART I
0z/ zZ00s FH .03 EVAR 3F $10,000.00 $0.00 $0.00
0z/ zoos LN .005 EWVAR 3F $10,000.00
0z/ zZ00s FH .03 EVAR =11) $20,000.00
0z/ zZ00s LM .005 EVAR =11) $20,000.00
0z/ zZ00s LM 005 0.04125 CL $15,000.00
0z/ zZ00s FH .03 EVAR PL $5,000.00
0z/ zZ00s LM .005 EVAR PL $5,000.00 -
4| | 3

"-'-_-_. »
Saves this document as a file. A

15. From the web browser, select File > Save As from the menu bar.
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16. In the Save Web Page window, select a folder to save the report in on your

hard drive. Name the report in the File Name field and then click on the

Save button. Be sure the save as type is ‘Text File'.

Save Web Pans

=

| Savem hipe: IText File [ tat)

Lel Lef Lo

Encoding: IWestem European [Windows)

SFICE

2]
Save in: I 25 My Documents = i
[y Music
My Pictures
Filz hame: ILenders Search Repart 877411| Save

N\

17.Right click on the Start button in the bottom left-hand corner of your

screen and select “explore”.

J:ﬂ & 50 |J Inl:u:ux...l

ederal Student PROUD SPONSOR o

Aw DFFICE of the UWE. DEPARTMEMNT of EDUCATION

15



Running a Lender Search Report - Lender

i} My Documents -8 =]

File Edit Vew Favorites Tools Help ﬁ

= Back + o= - ‘ Q) 5earch |%Fo\ders @“B 03 % @ | 5]~

Address I@ Py Documents j Pao
= 5 =
[H] Desktop = L@ anen
P My Documents e My Music My Pictures Print
= @. My Computer My Documents Scan For Yiruses. ..
=2 3% Floppy (A1) Notepad
1= Local Disk () Lenders Search Report 877411 Tk Bl &) Add to Zp
-3 BACKUP Text Document X X .
23 Microsaoft Excel For Windows £ Add ta Lenders Search Report 877411 zip
{21 Cognos Reports Modified: 6/3(2004 2:39 PM wordPad
-] Cognosén cines 6.5 KB Send To 4
128 5. Choose Pragram...
-0 DELL g at
- DISCOVER Attributes: {normal) Copy

=] Documents and Settings

(1 administrator Create Shorkout

(71 Administrator DEPARTME- Delete
-] Al Users Rename
-1 All Users, WINKT Propertios

-2 anthany.robinson

-] constance herron

" donald, adeyeye

(11 edward.corack

(] everistus.okorikwo

(1 howard.bonds

D joakim, raumain

-] satnam. khalsa

-] SMSCCMBootAcct

(2] SMaCisvesccts

-] SMSCiToknLocalbccts:
(21 Steve.Smith

(] SYSTEM

E[:I teresa.reynolds

L | Java

{1 conkies

i | Desktop

Favorites

+ D My Documents =
T e WP
4| | v

i start H & Eae |J Inbo...l How...l @Orac..‘l @Tool‘..l @Navi...l @Req...l @Find..‘l EeRep. . | @http...l @untit...“@m‘r |4j5®&° 2144 PM

18. Open the folder where the report was saved, right-click on the file, select
Open With and then select Notepad.
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& L enders Search Report 877411 - Notep 10 x|

| File Edit Format Help

ETY Chrl-H -
U.5. DEPARTMENT OF EDUCATION =
Oper... Ctr+O FEDERAL FAMILY EDUCATION LOAN PROGRAM
Sew s INTEREST FAYMENTS SUBSYSTEM
LENDER SEARCH REFORT
Save As...
Page Setup... LIO FOR ED ACCTG FFELP ADMIN USE OMLY WASHINGTON oC
Print... 2004 SERVICER IO: STATUS:ACCepted PROCESSING DATE: 06403/
Exit GROSS-INTEREST: $690, 35
GROSS SPECTAL ALLOWANCE: $0.00
LESS ORIGINATION FEES: %0.00
LESS LEWDER FEES: £0.00
TOTAL DOCUMENT AMOUNT: $£90, 35
F/B INT LM ENDING AVERAGE ==
OTRAYEAR  CODE  FEE  RATE T SAC BALANCE BALANCE ADIUSTMENTS
PART I
01/ 2004 LD .005  EVAR SF $1,326.00 $0.00 $0.00
01/ 2004 LN 005 EVAR 5F $1,326.00
01/ 2004 FO .03 EWAR 5F $1,326.00
01/ 2004 FN .03 EWAR 5F $1,326.00

FART I TOTAL

FPART IT

01/ zoo4 B 0346 SF $1%,8059.00 $1%,%21.00 $0.00

01/ zoo4 B .0dze SF $17,424.00 $13,540.00

01/ zo04 BiZ L0488 SF $24,545.,00 $25,159.00

le 2004 BC .08 SF $E526.00 $E5325.00

FART II TOTAL

FART III

o1/ 2004 B EWAR SF SE $&7,121.00 $70,451.00 -
1] | v 2

19. Once the document is open in Notepad, select File > Print from the menu
bar.
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NOTE: This screen may look different on your computer due to
configuration differences.

2l

&% Print

General Lapout | F'apera’llualit_l,ll

— Origntatian

" Paortrait
% Landscape

— Page Order

% Front to Back
™ Back ta Frant

Pages Per Sheet: I 1 vI

Advanced... |
I
| Pritt I Cancel | Apply |

In the Print window, click on the Layout tab and change the Orientation

20.
from Portrait to Landscape. Click on the Print button to print to kick off

the print job.
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